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MagBytes; the fine print 
This is a free New Zealand subscriber email info magazine from the NZ Apple news and info site mac-nz.com.
MagBytes tells you what’s happening and what’s new in the world of Apple every month, compiled from Mac NZ. 
Learn tips and how to do interesting things with your Macs and iDevices, and how to get more out of them. 
MagBytes is brought to you by Mark Webster, onetime editor of NZ Macguide magazine and a long-time trainer and commentator on Apple and the world of technology. 
Mark wrote about Apple for a worldwide audience on the New Zealand Herald under the title ‘Apple Watch’ (2009-2014) and at his Mac NZ Apple info site. You can store your issues of 
MagBytes on your HD, Thumb Drive or on CD/DVD, read it on screen, or even just drag it to iTunes (or to iBooks, from Mavericks) to have it appear on your iPhone and iPad (inside iBooks) 
next time you sync. Or print it out, even – and please feel free to pass MagBytes on. 
MagBytes is free to receive and you can opt out any time by sending an email here with ‘opt out’ in the subject line. The email list is guarded and private and held by Mac NZ for this purpose 
only. Find out more about the MagBytes Apple newsletter online (click on Mac NZ MagBytes Newsletter at top centre).

June 2015 ~ 
•2——Mac News ~ LGBT, 

freeing up space, Firewall,iTunes 
U homework, El Capitan, EFF, 

Jackson, Photos, LastPass, 
FileMaker 15, Swift 2, Music, Metal. 
•5——Updates ~ Flash probs, new 

Betas, synths, El Capitan, Quark, 
women in tech. 

 •6——Mac Help ~ In Northland, 
Auckland & Christchurch. 

•7—— iOS & iDevice news ~ App 
Store, Confederate flag, Beats 1, 

iOS 9, Apple Music, healthcare, 
Micosoft Sway, Swift (Taylor) 

iCloud, Cook and Watch, IBM and 
schools. 

•9——Tips & Tricks ~ Mac Finder, 
Photos, iOS calls and Reminders, 

Spotlight, Calendar. 
•13——Shiny & New ~ Friends, 

Foes and Feathers.

Monthly NZ newsletter of  things Apple for your edification and delectationMagBytes

Apple announced Apple Music, Swift 2, Metal, the next iOS (9) and Mac OS 10.11 (El Capitan) at the annual 
Worldwide Developers Conference in San Francisco early this June. Image is a still from Apple’s official video. 

This is late! So sorry, I got very 
busy and it just got away on me. 
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Mac News LGBT ~ freeing up space ~ your Mac’s Firewall and how to use it

Support for Same Sex marriage
When the US Supreme Court issued its historic ruling 
on Friday legalising same-sex marriage across the US, 
many of the biggest technology companies embraced 
the decision with characteristic flair through social 
media, on their sites, and with tools that others could 
use to show their support as well.
Apple Chief Executive Tim Cook praised the landmark 
decision by recalling his company’s famous Crazy Ones 
quote, co-written by his late, close friend Steve Jobs.

Creating space on Macs, iCloud
With platter/spinning drives on the way out (ie, hard 
drives), the days of easily getting a terabyte of storage 
in a laptop or even an iMac are perhaps not over, 
and while SSDs are super fast,they’re  expensive and 
smaller, in storage terms. 
There are several ways to create more space on your 
machine without having to pay an arm and a leg for 
more storage. And here’s how to safely disable iCloud 
Photo Library and reclaim space for iCloud backups. 
Further, a tutorial on iCloud Family Sharing.

Fire up your Mac’s fiewall 
While you can certainly spend money on firewall 
applications for your Mac — Norton Security will set 
you back a minimum of US$45 per year — your Mac, 
no surprise, already includes an excellent, built-in, 
free Application Level Firewall that, with minimal 
configuration, will do everything you need. 61 Hurstmere Road, Takapuna 09 486 1493

Authorised to service iPod, 
iPad and Mac

www.istorenz.com

Enhancing Your Apple Experience

Scan QR Code to quickly 
get in touch with iStore
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More Mac news is collated online

Mac News iTunes U homework ~ El Capitan ~ EFF ~ Jackson ~ Photos ~ Macs

THUNDERBOLT™ ADAPTERS 
AND CARD READERS

sonnettech.com

iTunes You adds homework
Apple’s iTunes U is set to be updated to 
allow students to submit homework 
through the app, and for course materials 
to integrate external apps, greatly 
expanding the abilities of its education-
focused platform.

El Capitan excitement
Jason Snell is not feeling a lot of love for 
OS X El Capitan out there. That might 
not be surprising, given that it’s firmly in 
the tradition of Mountain Lion and Snow 
Leopard–new-feature-light, speed-and-
stability-focused OS X updates. But bug-
fix and streamlining versions of Mac OS X 
are always the best …

Jackson now a Vice President
Apple has updated its executive leadership 
webpage to reflect Lisa Jackson’s new role 
as Vice President of Environment, Policy, 
and Social Initiatives, following a leaked 
memo published by the Washington Post 
that detailed these changes.

Award for VoiceOver 
Congratulations to Apple for receiving 
the Helen Keller Achievement Award 
for VoiceOver. The accessibility feature 
reads what’s happening on a device’s 
display out loud, enabling vision-impaired 
to use Apple’s devices more easily and 
successfully.

EFF top marks for privacy
Apple received top marks from the 
Electronic Freedom Foundation in the 
company’s Who Has Your Back? report 
for 2015. The report grades top tech 
companies in five categories relating 
to, “Online Service Providers’ Privacy 
and Transparency Practices Regarding 
Government Access to User Data.”

More about Photos 
Photos is the app that won’t stop until 
it drops. More answers to your Photos 
questions about working through 
missing features and potential bugs from 
Macworld.

Apple to replace iMac drives 
Apple has announced that some iMac 
owners whose machines are equipped with 
3-terabyte hard drives may be eligible to 
have their drives replaced free of charge, 
as those drives “may fail under certain 
conditions.”

Which Mac for you?
When it comes to purchasing a Mac, 
Macworld has the lowdown on each 
model to help you make a buying decision.

Fixing Mac slowdowns
Slowness can often be attributed to age: 
just because your 2010 MacBook Air can 
run Yosemite doesn’t mean it’s going to 
work out amazingly well for you. 
But even so, it’s best to figure out what’s 
going on. 
[Running Repair Permissions after a System 
update then restarting solves a whole lot of 
problems, in my experience – just click Help 
on www.mac-nz.com to see how.]
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Mac News LastPass ~ FileMaker 15 ~ WWDC Keynote ~ Swift 2 ~ Music ~ Metal

LastPass hacked
LastPass users will be prompted to change 
their master passwords after the online 
password locker company reported its 
network was breached. [This is partly why 
I don’t trust one-lock passwords, online or 
on Mac. You just need to hack one password 
to get access to all the others. In my case, 
you’d have to hack dozens of individual 
passwords.]

Free FileMaker training
FileMaker has announced the free 
availability of the FileMaker Training 
Series called Basics for FileMaker 14 online 
and it’s also on the iBooks Store.

Entire WWDC 2015 keynote
After hosting this year’s Worldwide 
Developers Conference keynote on its own 
website for a week, Apple made a video 
of the event 
available 
to a wider 
audience by 
posting a 
full-length 
version to 
its official 
YouTube 
channel.

Retina 5K iMac review 
The US$1999 iMac with Retina 5K display) 
is just about as good as its more expensive 
predecessor, writes Macworld. The display 
dazzles, and the performance will be 
appreciated by everyday users. (In New 
Zealand this is NZ$3049.)

Swift 2 poised to rock software
Apple’s Craig Federighi announced that 
Apple’s Swift 2 programming language 
would become open source. 
This decision will have spectacular 
consequences for the whole software 
world.
Apple’s Swift programming language 
is designed to be fast, less syntactically 
complex, less ambiguous and thereby 
more secure. However, to date, it has been 
restricted to iOS and OS X development. 
Of course, that’s not a bad thing, and 

Swift has walked 
the fiery coals of 
any language used 
for mass mobile app 
deployment. That’s a 
great opening act.
One ramification 
is that you will no 
longer require a Mac 
to write in Swift.

Apple Music
After months of rumour and speculation, 
Apple recently unveiled its first foray 
into paid music streaming with Apple 
Music. Featuring access to an extensive 
iTunes-based catalogue, human-curated 
playlists, Beats 1 radio and Connect social 
networking for artists, Apple Music 
promises to be one of Apple’s biggest 
releases for 2015.
Apple breaks down Music into three 
pillars: streaming tracks, Beats 1 radio and 
Connect. Separately, each leg can’t stand 
on its own, but together Apple hopes 
to offer a compelling option to industry 
giants like Spotify.

Apple introduces Metal for Mac
At WWDC, Apple SVP of Software 
Engineering Craig Federighi announced 
Metal for Mac, which combines the 
power of OpenCL and graphics crunching 
capability of OpenGL into a unified API 
that reduces draw rendering times by 50 
per cent. 
Metal is a core-level graphics technology 
that allows developers nearly untethered 
access to system GPU hardware for highly 
efficient processing, and it was first 
introduced in iOS 8 to speed up games and 
graphics-intensive tasks on iDevices.
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Adobe Flash exploit ... again
Yet another severe flaw in Adobe’s much-maligned Flash Player 
has been discovered and is being “actively exploited,” the 
company said on Tuesday, and users with Flash installed are 
being urged to upgrade to the latest version as soon as possible. 
Instructions for enabling automatic updates or manually 
updating Flash can be found here.  [All this is why Steve Jobs 
hated Flash.]

New developer betas
Public betas of OS X and iOS 
9 are coming next month, 
but developers just got new versions of those, plus watchOS 
2. Developers got their talented hands on the betas of OS X El 
Capitan, iOS 9, and watchOS 2 a couple weeks back at WWDC. 
On Tuesday, Apple released second versions of all three of those 
developer betas. To get developer betas, you need to be part of 
Apple’s Developer Program, which is now just one program — 
formerly, developers had to register separately for OS X and iOS.

New Alchemy-like GarageBand synths 
Apple has quietly revealed a forthcoming update to its 
GarageBand music production app that will add a number of new 
synths with shape-shifting controls, additions that seem to be 
influenced by Camel Audio’s popular Alchemy synth software, 
which Apple acquired earlier this year. Apple has teased some 
additional updates that are slated to arrive on June 30.

El Capitan Mac specs
When OS X El Capitan ships in about three months we will get 
some big improvements in performance on our Macs thanks 
to Metal, Apple’s system for vastly improving how computers 

handle graphics. There isn’t any official word yet on which Macs 
will support Metal, but here is some idea of what to expect 
thanks to the efforts of developers who have been digging 
through the El Capitan beta. Basically, that’s:
Nvidia GeForce GTX 400 series and newer
Intel HD4000 and newer (Ivy Bridge or newer)
AMD HD7000 and newer

You can see which graphics card is in your Mac by 
clicking the Apple menu and choosing About This Mac. 
Look for the Graphics  entry under the Overview tab. 
However, even if you can’t run Metal, all Yosemite-
capable Macs will be able to run El Capitan.

And here’s what’s missing from El Capitan.

QuarkExpress 2015 reviewed 
Quark continues to add features requested by QuarkXpress users, 
making this a must-have upgrade. 
The past several versions of QuarkXPress added features that 
were most requested in Quark’s user surveys, and QuarkXPress 
2015 continues this strategy. For example, they changed its 
version numbering scheme to indicate the year of release 
(otherwise this would be QuarkXPress 11), and the product is still 
offered with a traditional perpetual license rather than requiring 
an ongoing rental fee. [To my shame, I’d forgotten this even 
existed.]

Apple, women and tech 
The overwhelming majority of WWDC attendees are still male, 
but Apple has been stepping up its own efforts to encourage 
more women to take prominent roles in tech. That included stage 
time for female executives in leadership roles and the featuring of 
GoldieBlox to interest girls in engineering careers.

Updates Adobe Flash ~ dev betas ~ synths ~ El Capitan ~ Quark ~ tech women
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Apple support & 
AppleCare
Apple’s official support pages 
are comprehensive and cover all 
aspects of Apple hardware and 
software – it’s here.
Plus there’s Intro to the Mac and How Tos.
AppleCare: If you need your Mac fixed, 
look for an Apple licenced repair centre. 
People often ask me if they should buy 
AppleCare with their devices. 
Every new Mac has a one-year warranty 
and 90 days free phone support. 
AppleCare extends this all out to three 
years. Under NZ law, you are covered by 
the Consumer Guarantees Act against 
anything going wrong that comes 
down to parts failure within reasonable 
expectations (say, inside three years’ use), 
but be prepared to spend anxious time on 
the phone, sticking to your guns to get it 
fixed. 
However, this absolutely does pay off.
AppleCare is expensive, depending on the 
device, but it’s a replacement policy which 
covers you anywhere in the world. 

If you travel and you want full reassurance, 
and you can afford it, AppleCare is superb.

Mac Senior Net — ready to help
If you are aged 55 years or better and you 
use an Apple computer or device, Mac 
Senior Net is a wonderful resource.
 
Auckland: Mac Senior Net Auckland 
provides on-going Apple Mac and iDevice 
knowledge to help competency, learnt 
alongside others in similar situations. 
The Auckland Club holds monthly 
meetings in Howick, Bayswater and 
Remuera and provides lessons and talks 
very reasonably. Go to MSN Ak’s web page 
or email Marion Moffat.
Handy Absolute Beginners’ courses are also 
available at SeniorNet, including for iPads.

Christchurch: With nearly 600 
members, this very active Apple-
focussed group covers Christchurch with 
a dedicated lab – and caters to the city’s 
surrounds by running iPad sessions in 
rest homes. This is a large, well-run and 
successful group.

Mac & iDevice training in Grey 
Lynn, Auckland 
You’re getting MagBytes and may be 
following my weekly Friday tips on Mac 
NZ – but I also run the Grey Lynn Sessions 
in Auckland (click on Training). This is the 
cheapest way to learn, at $40 per session 
in a friendly, group environment. A new 
series is starting Wednesday March 4th at 
7:30pm. Please email if you are interested 
in attending, as I only book a room when I 
can guarantee five attendees. The sessions 
are friendly, open to questions at all times 
and are backed up by handouts, and one 
is running now on Wednesday nights 
(7:30pm). I train (one-to-one at your home 
or workplace (in Auckland) for $95/hour. I 
also present to institutions.
Please email Mark for more info.

Mac diagnostics
Your Mac has various diagnostic tools and 
routines available. If you think things are 
going awry, check the Help page on Mac 
NZ (click on Help at the top).

Mac help in the North 
Dave Boswell has been a reseller in 
Whangarei for 20 years and can assist. 
MacNorth Computers 09 433 9855,  
027 490 2332, or email Dave Boswell.

Mac Help Apple assistance
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iDevice news
App Store LGBT content
In celebration of efforts made toward 
gay, lesbian, bisexual and transgender 
rights equality, Apple has added a 
special section to the iOS App Store 
pointing to movies, music, TV shows, 
apps and other online media it says 
reflects LGBT pride.

iOS 9 Low Power Mode
But at least you get to actually 
use your iPhone’s features, rather 
than enabling Airplane Mode and 
frantically searching for a power 
outlet.

Confederate Flag 
Apple on Friday reinstated a number 
of games recently stricken from the 
iOS App Store for bearing references 
to the Confederate battle flag, a 
polarising symbol that some equate 
to slavery in America.

Beats 1 celeb DJs
Apple will indeed have a number of 
mainstream musicians host shows on 
Beats 1 including Drake, Disclosure, 
St. Vincent, Josh Homme, Pharrell 
Williams, and Elton John, a report said 
on Thursday.

LGBT ~ iOS 9 ~ that flag ~ Beats 1 gets celebrity DJs
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iDevice newsApple Music ~ Healthcare ~ Microsoft ~ iCloud ~ Schools

Apple Music Radio for iOS 8.4 & iOS 9
The native Music app in Apple’s iOS 8.4 and iOS 9 betas has been 
updated with access to a new Radio tab, including a preview of 
the company’s new live, flagship radio station Beats 1.

Apple and the Consumerisation of  healthcare 
With the iPhone an everyday part of millions of consumers’ 
lives, and now the debut of the Apple Watch, healthcare 
professionals believe Apple is a pivotal part in what they see 
as the ‘consumerisation’ of healthcare, driven by easy access to 
health-related data.

Microsoft’s Sway and Windows 10
 Joining the ranks of other Windows 10 universal apps this 
summer will be Microsoft’s lightweight content-creation tool, 
Sway. Before that, however, it’s making the leap to the iPad.

Taylor Swift gets her way 
with Apple Music
Apple Senior Vice President of 
Internet Services and Software 
Eddy Cue told Billboard magazine 
that Taylor Swift’s open letter for 
better artist payments ‘solidified’ 
the need to change Apple Music’s 
artist compensation plan. 
He said Apple had been discussing 
the issue for the last week, but that 
her letter helped push them to 
make the decision. [Right on, Cue.] 

Picture, left, from the Guardian.

How to backup your iPhone to Apple’s iCloud
When iPhone first launched, backing up data was a cumbersome 
process that required users to transfer their files to a Mac or 
PC via iTunes. Apple has since moved to the cloud with iCloud, 
providing an incredibly simple way to back up iPhones, iPads and 
iPods without a host computer.

Tim Cook says Watch attracting more dev interest
Apple Watch has only been available for a very short time, but 
it’s already attracting more developer interest than the iPhone 
or iPad did early on. That’s what Apple CEO Tim Cook told an 
interviewer from the Chinese version of Bloomberg Businessweek.

Apple, IBM on app for teachers
The Coppell Gazette reports that Apple and IBM have been 
working on a Student Achievement App aimed at educators. 
Representatives from both companies attended a meeting of the 

Coppell ISD Board of Trustees to discuss 
the solution, which will provide teachers 
with “actionable intelligence on a per-
student basis.” The app will reportedly run 
on Apple hardware exclusively.

A New York school district 
converts to Apple iPad
All students in grades 3 through 9 in the 
affluent Mineola, NY, school district have 
been equipped with Apple’s iPad, in an 
aggressive and ambitious initiative that 
has converted some 75% of its students’ 
instructional days to the touchscreen 
tablet.
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Mac Finder, searching and top-right menus ~ Photos and its featurestips&tricks
1/ The Hover — If you want to move a file 
back one folder in your navigation, just 
pick it up and hover over the Back button 
in the upper-left corner of your Finder 
window. When you do so, the window 
will jump back one step, and then you can 
drop your file into its new location. (If you 
haven’t navigated to your current folder 
from anywhere, the Back button will be 
greyed out, and this won’t work.)

2/ Path Bar — If you need to 
move something several steps 
back in the hierarchy of your file 
system, an easy way to do so is to 
turn on Finder’s View> Show Path 
Bar option. You can thendouble-
click in any of the folders along 
the bottom of Finder windows to 
open that folder.

3/ Cut and paste — Select a file 
you want to move and press 
Command-C (Edit> Copy). Then 
go to the location you’d like to 
place the item and press Option-
Command-V (the shortcut for 
Edit> Move Item Here, which is 
only visible if you hold down the 
Option key when you’re looking at 
the Edit menu).
That action — available from 10.7 Lion and 

up — is equivalent to the PC’s familiar cut 
and paste option. (These three tips came 
from Mac Observer.)

4/ Smarter Finder searches — Lost a 
file? In the Finder, Command-F presents 
a traditional Find window in which you 
you can search for contents, a created 
date, kind, and so on. But if you know 
you’re looking for a file by name, use 
Shift+Control+Command+F instead. You 

get an abbreviated search window that 
concentrates on file names.

5/ Rearrange top right menus — These 
configurable menus tend to be turned on 
in System Preferences (ie, Sound, WiFi) 
or added by third party utilities and apps. 
If you don’t care for the way icons are 
arranged in the menu bar, just hold down 
the Command key and drag the item in 
question to a new position. Be careful to 
not drag it outside the menu bar, however, 
as doing so can cause it to evaporate. (This 
trick doesn’t work with the Spotlight or 
Notification menus as they need to stay at 
extreme right.)

Photos on Mac
1/ Find your images on a map — With 
the Info pane visible (from the Windows 
menu, choose Info), any image, video, 
or multiple selection that contains 
geotagging information will appear on a 
map at the pane’s bottom. With nothing 
selected, the Info pane shows the coarse 
placement of all photos in your library. 
You can zoom in to see fine detail about 
where images are clustered, but there’s 
no way to select a moment from that 
map – an oversight that will hopefully get 
corrected one day.
When viewing moments, if there are one 
or more geotagged media items in the set, 
the label for that place or range of places 
appears as the moment name in bold. To 
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Photos on Mac (continued)tips&tricks
the right of the moment’s name, a broader 
place name appears in fainter type. Click 
that, and a full-window map shows all the 
moment’s photos.

2/ Organisation versus iPhoto — If you 
aren’t seeing a list of albums and other 
special items at the left of Photos, choose 
View > Show Sidebar.

3/ Time increments for Moments — You 
can show larger increments of time, up 
to years, and click the location. You can 
opt to show in larger or smaller groups by 
checking or unchecking the Summarize 
Photos option in Photos > Preferences in 
the General pane. (Photos automatically 
identifies moments: there’s no way to 
override and create them yourself.)

4/ Share photos online on Mac and 
iOS — iCloud Photo Sharing is a private 
and secure way to share digital memories 
with certain people. When you create or 
subscribe to a shared album, it appears on 
all of your devices. iCloud Photo Sharing 
does not count against your allotted 
storage space for free iCloud accounts, so 
it’s free.
Turn on iCloud Photo Sharing on all your 
devices (this has nothing to do with iCloud 
Photo Library). In Photos for Mac, choose 

Photos > Preferences and in the iCloud 
pane, turn on iCloud Photo Sharing. On 
an iOS device, tap Settings and then scroll 
down until you see Photos & Camera. Give 
it a tap and on the next screen, tap the 
switch next to iCloud Photo Sharing (it 
turns green).
Creating (and adding content to) shared 
albums is mercifully simple: in Photos on 
Mac, select an album or some thumbnails. 
Click the share icon in Photos’toolbar 
and choose iCloud Photo Sharing. In the 
resulting sheet, click New Shared Album, 
and then on the next sheet, name the 
album and invite someone to subscribe to 
it by entering their name, email address, or 
cell phone number into the To field. In the 
Comment field, enter a description of the 
goodies you’re about to share.
When you’re finished filling out the all the 
fields, click Create. Your invitees promptly 
receive an email invitation to subscribe to 
your album. Once they click the Subscribe 
button in the email, the shared album 
appears in Photos’ Shared view on all the 
devices on which they’ve turned on iCloud 
Photo Sharing. Creating a shared album 
in Photos for iOS works the same way, 
though you can’t select a whole album 
for sharing: You have to select individual 
thumbnails instead (bummer!).
To like and comment on an item in a 

shared album in Photos for Mac, open the 
album, double-click a picture or video and 
then click the “+” icon that appears in the 
picture’s lower-left corner (it looks like a 
thought bubble). 
When you do, the comment sheet shown 
below appears. Click the smiley-face icon 
to like it, or click in the comment field and 
enter something pithy. Click Send, and 
Photos adds your comment to the list.
To like an image or add and view 
comments in Photos for iOS, tap to open 
the shared album, and then tap the picture 
itself to open it. 
Beneath the picture, you see controls that 
let you like the image, view comments, 
and add your own. 
To delete a comment, tap and hold 
your finger down on it, and then tap the 
Delete button that appears just above 
the comment. (There’s more on this at 
Macworld, by Lisa Snider.)

5/ Eight ways to get photos onto your 
Mac and iDevice — There are several 
convenient sidedoors into Photos that 
work whether the program is running or 
not. 
My favourite on Mac is Image Capture, 
an Apple app already on every Mac. 
Macworld has a rundown.
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iOS 8: make calls from Reminders and moretips&tricks
1/ Make calls straight from Reminders — 
Apple’s Reminders app can come in handy 
on your iPhone, particularly since it’s very 
easy to create them using Siri. To make a 
call from Reminders, create a reminder like 
‘Call Jo Public at 8am’. Make sure it starts 
with “call” and that you have the person in 
your Contacts already.
When you have it set up, it’ll pop up at the 
right time to remind you. When you see it 
on your lock screen, put your finger over 
it and swipe left, and the option to call 
directly appears if the reminder includes 
a contact with a phone number even in 
the lock screen. Now you 
can save steps when you’re 
using Reminders to set up 
phone calls.

2/ Switch between day 
and list view — If you 
tap on a date in Calendar 
on your iPhone, you’ll 
get an expanded view of 
your daily appointments. 
Scroll up and down to see 
which hours are free and 
which are booked, with 
each event colour-coded 
depending on the calendar 
it’s assigned to.
In the day view, you’ll find 

the list button (it looks like a tiny bulleted 
list, shown above) in the top-right corner 
of the screen, to the left of the Search 
field. Tap it, and your upcoming events are 
arranged in one big, scrollable list (left).
(There’s no list button in the iPad version 
Calendar—you just have the monthly 
view, which boasts details for each day’s 
events.)

3/ See your entire week on your iPhone 
— The iPad version of the Calendar app 
has four clearly marked views to choose 
from: Day, Week, Month, and Year. On an 

iPhone, the Day, Month and 
Year views are (relatively) 
easy to find, but what about 

the Week view? Just tilt your iPhone into 
landscape orientation (below) and your 
week will twirl into view, no matter which 
calendar view you were checking.

4/ See event details from the month 
view — The standard month view in 
Calendars for iPhone offers a blank, rather 
unhelpful grid of dates — tap one, and 
you jump to the expanded daily view. To 
see the whole month again, you’ll have 
to tap the Back button. But the Details 
button, which sits unobtrusively next to 
the Search button in the top corner of 
the screen, shows a list of events for the 
selected date, with the rest of the month 
still visible. Tap another day of the month, 
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Calendar on iOS and Spotlight searchestips&tricks
and you’ll see the events for that day. 
Switch months by swiping up and down.

5/ Drag and drop calendar events — The 
most obvious way to change the time of 
an event in Calendar is to tap it and edit 
its “start” and “end” times, but there’s 
actually a much easier way.
Just tap and hold an event until it pulses, 
then drag it anywhere you like in your 
calendar. You can also grab one of the 
little handles above or below an event 
to pad it out or cut it short.

iOS and Spotlight searches
1/ iPhones and iPads have search — 
Just like Spotlight on Macs, in fact, 
but to some this remains a hidden 
feature: to launch Spotlight on an iOS 
device, swipe down on its screen – not 
from the very top of the screen; that 
displays Notification Center.
Start in the middle of the screen and 
swipe downwards – your finger should 
be moving downwards before it 
actually contacts the screen.

2/ Results from all over — Start 
typing in the text input field at the 
top, , and your iOS device will start 
showing you results, just as on OS 
X. As you continue typing, you’ll see the 

results change, as Spotlight zeroes in 
on what you’re looking for, showing you 
a number of different types of results, 
including your apps, words in emails, 
Calendar and Contacts, websites, Map 
locations and more.
But, oddly perhaps, you cannot search for 
files on iCloud Drive.

3/ iOS 
Spotlight is 
a launcher 

— Tap an app to launch it; tap a song 
to play it; tap any other item, such as a 
contact, email message, or web page, to 
open it in the appropriate app. Spotlight is 
great for launching an app that’s hidden in 
a folder somewhere on your iDevice.

4/ Searching the web — Spotlight can 
search for content on the Internet. It 
suggests matches from search terms 
among Wikipedia articles, news, content 
on the iTunes Store, App Store, and iBooks 

Store, as well as nearby places. 
These searches fall under the 
Spotlight Suggestions category. (For 
nearby places to work, you need to 
have Location Services turned on in 
the Privacy settings.) 
Spotlight Suggestions are available 
in New Zealand, and only 14 other 
countries.

5/ Specify the results you want — 
Choose which categories Spotlight 
displays when you search. Go to 
Settings>General> Spotlight Search 
and check or uncheck any of the 
categories you see. 
You can also change the order in 
which they display. To do this, tap 

and hold one of the rows and drag it up or 
down in the list.

Dragging downwards on the Home Screen goes through a blurry 
transition into Spotlight (right)
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shiny&new
Friends Foes and Feathers:
June, Anne and the Great War 
by Lynda Johansson Nunweek

CreativeTech’s third 
multi-touch electronic 
book for the Apple 
*iBooks platform 
tells the story of new 
friends June and Anne. 
Each has a brother old 
enough to fight (the 
book starts in 1915) 
but Anne’s brother 
has a conscientious 
objection to warfare 
while June’s brother 
is soon far away with 
the Anzac forces at 
Gallipoli.

While around 100,000 New Zealanders 
were directly involved with the military in 
World War One, another 900,000 or so 
were back home in New Zealand. 
Friends, Foes and Feathers tracks two of 
those families, and handles complex issues 
of friendship, loyalty and what it meant to 
be New Zealanders in troubled times. 

Drawn from experiences relayed through 
author Lynda’s families and set in 

Not much to shout about except for a delightful new iBook 

Auckland, Friends, Foes and Feathers tracks 
the social, economic and natural change 
as New Zealand evolves from a Dominion 

to nationhood through 
the eyes of two girls 
and their parents and 
siblings.

Perhaps most 
excitingly, this is the 
first in a series of 
seven that will track 
characters introduced 
in June, Anne and the 
Great War right up to 
the end of the 20th 

Century. In ‘chapter 
book’ style and 
lovingly illustrated by 
award-winning artist 
Diana Curtis, each 
book can be enjoyed 
by anyone with an 
interest in this period. 

Friends, Foes and 
Feathers is designed 

to be used by students and teachers in 
modern interactive learning environments 
(it costs NZ$7.99 in the iBooks Store for 
iPad, Mac and iPhone 6 – not iPhone 4 or 
5). It includes a glossary, and Word Sleuth 
and Reading Circle elements. 
It is also available in the Apple Volume 
Purchasing Program for bulk buying.
Follow this link to buy it or download a 
free sample chapter. 

[Disclosure: Friends, Foes and Feathers was 
designed and published by CreativeTech 
Ltd, of which Mac NZ’s Mark Webster is 
co-director with Paul Luker.]

mailto:mac.nz%40me.com?subject=From%20MagBytes
mailto:mac.nz%40me.com?subject=From%20MagBytes
https://itunes.apple.com/nz/book/friendship-foes-feathers-june/id1010007124
https://itunes.apple.com/nz/book/friendship-foes-feathers-june/id1010007124

